
 

 
Movavi Screen Capture 7

 
Don't know where to start?

Read these tutorials:
Recording screen

Capture any fragment of your
screen or the full desktop.

Capturing online video
Record video from online video

websites such as YouTube or Vimeo.

Capturing video from players
Record any video in your player.

Capturing Skype calls
Record Skype calls with sound from both ends.

Recording only audio
Record any sound from a device

or music on your computer.

Need more help?
Write to us at support@movavi.com

Or click here to open live chat.

mailto:support@movavi.com
https://chatserver.comm100.com/ChatWindow.aspx?planId=1190&visitType=1&byHref=1&partnerId=-1&siteid=27345
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Removing trial restrictions
When you first start your copy of Movavi Screen Capture, it will be running in LIMITED TRIAL MODE. In trial mode, you can try out all of the main features, but the
following trial restrictions will apply:
 
TRIAL VERSION FULL VERSION

 Movavi Screen Capture will stop working after 7 days  Lifetime license

 A watermark with the words ' trial version' will be added to all exported videos  No annoying watermarks

 Capture time is limited to 2 minutes per video  Unlimited capture time
  Free updates
  Discounts on other Movavi products and upgrades
 
In order to upgrade to the full version, follow the instructions below to activate Movavi Screen Capture:
 
Step 1: Buy activation key
1. Click the button below to go to the purchase page and click the Buy Now button there.
2. You will be taken to our web store. Fill in your billing information and payment options and proceed with the purchase form. IMPORTANT! Be sure to enter a valid e-
mail address: it will be used to deliver your activation key.
3. Once you have placed your order, you will shortly receive a confirmation for your order and an e-mail from support@movavi.com containing your activation key.

Step 2: Open the activation window
1. Open Movavi Screen Capture
2. On the capture control panel window, open the Help menu and select Activate Software. The activation window will open:

Step 3: Enter your activation key
1. Enter the activation key into the corresponding box.
2. Click Activate to complete the activation and restart Movavi Screen Capture.

Having problems with activation?
If activation is not working as expected, try the following:

• Make sure that the activation key is entered correctly and is intended for the program you are activating.
• Try activating offline via e-mail.
• Contact us at support@movavi.com and we'll help you solve the problem!

 
Activating without Internet access
If the computer you have installed Movavi Screen Capture on is not connected to the Internet, you can activate the program via e-mail.
See detailed instructions
 

http://www.movavi.com/screen-recorder/buynow.html?asrc=sc_help
http://www.movavi.com/screen-recorder/buynow.html?asrc=sc_help
mailto:support@movavi.com
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Getting an activation key
1. To purchase an activation key, open the Help menu in Movavi Screen Capture and select Buy Now or just use the button below.

2. Choose a personal or business license and click the corresponding Buy Now button.
If you intend to use Movavi Screen Capture commercially, that is, to obtain profit of any kind or in a government organization, you need to select a business license.
 
3. Fill in your billing information and enter a valid e-mail address. This e-mail will be used to deliver your activation key, so make sure you have entered it correctly and
that you have access to it.
 
4. After you've completed your payment and your request has been processed, you will receive a confirmation e-mail with your activation key, which you can use to
activate Movavi Screen Capture.

If you haven't received your activation key:

• Check the Spam folder of your mailbox
• Contact support

http://www.movavi.com/screen-recorder/buynow.html?asrc=sc_help
http://www.movavi.com/screen-recorder/buynow.html?asrc=sc_help
http://www.movavi.com/support/contact.html
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Activating Screen Capture
Activating Movavi Screen Capture will allow you to remove all of the trial restrictions and use the program forever.
 
You will need:

• Movavi Screen Capture activation key. You should receive your key via e-mail right after your purchase is completed. Don't have a key? Buy now
• Internet access. Don't have Internet access? See this guide on offline activation

 
Step 1: Open the activation window
1. Launch Movavi Screen Capture.
2. Open the Help menu and select Activate Software.

 
The following dialog box will appear:

Step 2: Enter your activation key
1. Enter or paste your activation key into the corresponding box of the Activation window.
2. Click Activate to verify your activation key.
 

If you have entered the key correctly, you should see a message confirming successful activation.  Click OK to complete the activation process and restart the program.

If online activation fails, try the following:

• Check that the activation key is entered correctly and is intended for the program you are activating.
• Make sure you have administrator rights on your computer.
• Try offline activation.
• Contact support.

 

http://www.movavi.com/screen-recorder/buynow.html?asrc=sc_help
http://www.movavi.com/support/contact.html
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Activating without Internet access
Activating Movavi Screen Capture will allow you to remove all of the trial restrictions and use the program forever. If you don't have Internet access on your computer,
you can use any other computer or mobile device to complete the steps that require a connection.
 
You will need:

• Movavi Screen Capture activation key. You should receive your key via e-mail right after your purchase is completed. Don't have a key? Buy now
• A device or another computer that can be used to send and receive e-mail

 
Step 1: Open the activation window
1. Launch Movavi Screen Capture.
2. Open the Help menu and select Activate Software.

Step 2: Enter your activation key
1. Enter or paste your activation key into the corresponding field.
2. Select the Activate offline option.
3. Click Activate to proceed to the next step.

Step 3: Send an e-mail with the provided information
The next window contains important activation information that you will need to send us via e-mail in order to activate your program.

1. Click the Copy button to copy the information in the window. If necessary, save or transfer this information to the computer or device that you will be sending the e-mail
from.
 
2. On the computer with an Internet connection, open your mail client and compose a new e-mail. Paste the information you've copied earlier into the message body and
send this e-mail to reg@movavi.com. The activation server will then verify your activation key and send you an automatic response containing a registration key, which
you will need to enter into the Activation window. You should receive the server's reply within an hour.

http://www.movavi.com/screen-recorder/buynow.html?asrc=sc_help
mailto:reg@movavi.com
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To ensure a quick reply from our activation server, please do not alter the message subject or body
 
Step 4: Enter your registration key
1. When you have received your registration key, save it and go back to the Activation window.
2. Enter the registration key into the corresponding box.
3. Click Activate to submit the information.

If everything is correct, you will see a successful activation message. Click OK to complete the activation and close the activation wizard.
 
Once activation is complete, you may be asked to restart the application. If you have entered the key correctly, you should see a message confirming successful
activation. Click OK to complete the activation process and restart the program.

If offline activation doesn't work:

• Make sure you have entered the activation key and the registration key correctly and try again
• Check that you are activating the right application.
• Make sure you have administrator rights on your computer

 
If you have any questions or problems while activating your Movavi software, feel free to contact us and we'll help you out!
Our e-mail: support@movavi.com

mailto:support@movavi.com
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Tutorials
These tutorials will guide you on the most popular screen recording tasks:

 
Recording screen

Capture any fragment of your
screen or the full desktop.

Capturing online video
Record video from online video

websites such as YouTube or Vimeo.

Capturing video from players
Record any video in your player.

 
Capturing Skype calls

Record Skype calls with sound from both ends.
Recording only audio

Record any sound from a device or music on your computer.
 

Need more help?
Feel free to contact us at support@movavi.com and we'll help you out!

 

mailto:support@movavi.com
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Recording screen activity
 
Step 1: Choose the capture area
First, you'll need to set which part of the screen you want to record.
 
To record the full screen
Open the list in the left part of the control panel and choose your display under Full Screen.

To record a window
On the capture control panel, click the crosshair button and then click on the window you want to capture. An orange capture frame will appear around the window.

To record a custom fragment
On the capture control panel, click the crosshair button. Then, click and drag to draw the capture area on the screen.
Learn more about the capture area

Step 2: Choose audio sources
Next, we'll select what sounds you want to be heard in your video.
 
Music or sounds from your computer
To enable recording sounds from your computer (any music, videos, applications, and alerts), click the System Audio button. Use the slider to the left of the System
Audio button to manage the volume of the recording.

on          off
Microphone or audio device
To record from an external device, click the microphone button and select the device you want to use from the list below it. Use the slider to the left of the microphone
button to manage the device's volume.
Learn more about audio

on          off
Step 3: Extras

•
If you want to limit the length of the recording or record at a later time, use the Capture time options button: 
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Learn more

•
If you want to display your mouse during capture, click the Cursor options button: 

Learn more
 

•
If you want to show which keys you pressed during recording, click the Record keystrokes button: 

Learn more
 
Step 4: Set the volume
Before you start a recording, you can adjust a volume level for both system audio and recording devices.
To change the volume level, simply drag the sliders up or down.

Step 5: Record the screen
When you're ready, click the REC button to begin recording. The capture control panel will change to show recording options. Here, you can also keep track of how big
the recording is going to be.

To pause the recording, click Pause. When you're ready to continue, click the Resume button.
To finish the recording and proceed to saving, click Stop.
To terminate and delete the recording, click Cancel.
Learn more

Step 6: Save the video
After you end the recording, you can preview the result and choose how you want to save the captured video.
 
Click the 'Save as' box and select the format you want to save the video in.
 
To save as a video format
Click Video and Audio at the top of the list and select the necessary format and resolution.
 
To save for watching on a device
Click Devices at the top of the list. Find your device's manufacturer and click on it, and then select the device's model. This will save the video in a format that is
guaranteed to be supported by the selected device.
 
Finally, click Save to start processing the video.
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Capturing online video
This manual describes how to capture videos from YouTube. You can also follow the same steps to capture video from other video sharing websites, webinars, sports
broadcasts and any other online video.
 
Step 1: Choose video quality
Many video streaming websites, including YouTube, allow you to select the quality for playing back the video. For the best results, choose the highest available video
quality  and, if possible, allow the video to load fully before starting capture.
 
Step 2: Define the capture area
In the Select Capture Area section, open the list of pre-defined capture area sizes and choose one from the YouTube section:
 

640х360 – default YouTube player size

854х480 – extended theatrical mode size. You can toggle sizes by clicking the Theatrical mode  button in the YouTube player. 
 

The capture area frame will be set to the selected size. Then, place the frame over the YouTube player so that the player's control panel is outside the frame by dragging

the frame by the orange position icon .
If you want to capture a fullscreen video, open the list of pre-defined sizes and choose the option under Fullscreen. If you have more than one monitor, you will be able
to choose which one to use for capturing video.

 

You can find out more about setting up the capture area here.
 
Step 3: Choose an audio source
On the capture settings panel, click the System Sound button to enable capturing sounds from programs and your system, including the online video player.
 

off            on
 

Make sure that other sound sources on your computer (for example, videos, streaming music, and ads in other browser tabs, audio players) are muted or disabled to
avoid capturing unnecessary sounds. Next, to further reduce noise, we recommend that you disable capturing audio from external devices.

off               on
If your computer is running Windows XP, please refer to Troubleshooting in the Recording Audio section for capturing system sounds.
 
Step 4: Set up mouse visibility

Click the cursor icon  to display the mouse cursor settings panel. To hide the cursor during recording, disable the Show cursor option.
Learn more about additional capture options
 
Step 5: Start recording
Make sure that the window with the video player is in the foreground of your desktop. If you've selected the fullscreen capture mode, don't forget to enable fullscreen
playback in the player as well. When you're ready, click the REC button or use the start capture hotkey to begin recording. The Movavi Screen Capture control panel will
switch to recording mode.
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During capture, you can temporarily pause the capturing process by clicking the Pause button. If you're capturing in fullscreen mode, the control panel will be minimized
to the system tray. In that case, you can click the Movavi Screen Capture icon in the tray to pause or stop capture, or use the hot keys.

Step 6: Save your video
To finish recording and proceed to saving your video, click the Stop button or press the F10 key (the default stop capture shortcut, your keyboard shortcut settings may
be different). The player window will appear.

In the Save as list, choose a format you'd like to save the video in and click Save. Your video will be ready in a few minutes.
Learn more about saving captured videos
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Capturing video from players
1. Set up the capture area.
For capturing videos playing in video player applications, it is best if you capture the video as close to its original size as possible. That is, if the video you want to capture
has a resolution of 1280x720 pixels, we recommend that you set the capture area to the same size. Most video players have a Zoom option, where you can set the zoom
level to 100% or 1:1. If the video is larger than your screen size, you can set the capture area to record the entire screen and then play the video in full screen mode.
 
To set a fullscreen capture area:
In the Select Capture Area section, open the list of pre-defined capture area sizes and select the option under Fullscreen. If you have more than one monitor, you can
choose which monitor to use for fullscreen capturing.

To capture a player window:
Click the crosshair button in the Select Capture Area section to enable smart capture area selection. The screen will dim slightly. Then, draw the capture area inside the
player, so that the player's window is completely outside the frame. When you release the mouse button, this rectangle will be set as your capture area.
Learn more about the capture area

2. Set up the sound
When you want to record audio from applications, you will need to enable the System Sound option. Click the speaker icon in the Movavi Screen Capture control panel
window to enable capturing sound from players and other programs. As this allows Movavi Screen Capture to record all system sounds, make sure to disable sound
alerts in other applications to avoid unwanted noise in your video.
Learn more about sound recording
 

on          off
 
3. Start Recording
To begin recording, click the red REC button or use your Start\Stop capture shortcut.

If you want to capture a fullscreen video:
1. If you don't remember your start and stop capture hot keys, open the Preferences window, and review them or set different ones in the Keyboard Shortcuts tab.
Don't forget to close the preferences window before starting playback.
2. In your player, switch to fullscreen mode and launch playback
3. To begin recording, press your Start\Stop capture keyboard shortcut. 
 
When you want to end capture, click the Stop button or use the Start\Stop capture shortcut again and proceed to saving your video.
Learn more about recording videos
 
4. Save the Video
After you've finished capturing the video, you can preview the result in the player and save the video.
If you want to trim the video, move the triangle markers on the progress bar towards the center.
Open the list under Save as and choose the format you want to save your video in. You can also prepare the video for viewing on mobile devices or sharing online.
When you've selected a format, click Save to begin processing the video.
Learn more about saving captured videos

Troubleshooting:
Some video player programs have video output settings that prevent capturing video and taking screenshots. If you are having trouble recording video from any of the
following players, follow the steps to change the player's settings and enable video capturing.
 
Capturing video from VLC (VideoLan Media Player)
(for Windows XP users)
1. In VLC player, open the Tools menu and choose Preferences.
2. Switch to the Video tab (in Simple mode)
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3. In the Display section, find the Output list. If DirectX (DirectDraw) video output is selected, try using a different output mode.
 
Capturing video from Media Player Classic
(for Windows XP users)
1. In Media Player Classic, open the View menu and select Options.
2. Go to the Playback > Output section in the tree on the left.
3. Find the DirectShow Video option. Here, you can choose from a list of video renderers that will affect how the player displays video on your screen. If the Overlay
Mixer Renderer is selected, select any other renderer from this list.
4. Click OK to accept the changes.
 
Capturing video from Windows Media Player
(for Windows XP users)
1. In the main player menu, open the Tools menu and select Options.
2. In the Options window, switch to the Performance tab.
3. Click the Advanced button.
4. In the Video Acceleration section, find the Use overlays option and deselect it.
5. Click OK to accept the changes.
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Capturing Skype calls
When you record audio or video calls using Skype or a similar program, it is important that you record both ends of the conversation. To do that, you will need to record
input from your microphone or webcam, as well as the audio from your speakers. Follow the steps below to record Skype calls with audio.

1. Launch Movavi Screen Capture.
 
2. Select audio sources:
 

• Click the System Sound button to enable capturing the sounds that you hear in your speakers, including your Skype interlocutor. 
 

• Click the microphone icon to enable capturing audio from external devices.
 

• Open the list beneath the microphone icon and select your microphone or another device that will capture your voice.

3. Adjust the size of the Capture Area to the call window. To do that, click the crosshair button in the left part of the window, and then click and drag your mouse from one
corner of the Skype call area to another. When you release the mouse button, the Capture Area will have the same size and position as your Skype window.
You can find more information on how to set the size and position of the Capture Area in the Defining the Capture Area section.

4. Now that everything is set it's time to make that call!
Click the orange REC button to begin recording your call. You will be given a five-second countdown to prepare. If you want, you can disable the countdown window in
General Preferences.

5. When you're done, click Stop in the main Movavi Screen Capture window or press F10 to finish capturing and proceed to saving the video.
You can change the Stop Capture hotkey in Preferences under Keyboard Shortcuts.

Don't forget to save the captured video!
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Record audio only

Movavi Screen Capture can help you not only record any screen activity, but it can also function as a sound recorder to record online music, radio broadcasts, and voice
input.
 
Step 1: Set up Audio
Naturally, if you want to record an audio file, you'll need to enable audio recording.

• To capture audio from your computer, make sure that the System Audio option is enabled.
• To capture audio from a microphone or an external device, click the microphone icon and choose the device you will be using for recording.
• To capture Skype audio, you'll need both options enabled in order to capture the audio from the other end of the call as well your own microphone input.

Here, both System Audio and device recording are enabled.
 

Troubleshooting audio:
If you don't see the device you want to use in the list, it may be disconnected or disabled in system settings.
1. Right-click the sound icon in the Windows notification area and choose Recording Devices from the pop-up menu. The Sound settings window will open.
2. In the Recording Devices window, look for the necessary device in the list. If it is detected and enabled in your system, there should be a green checkmark beside it.
3. If you cannot find the device in the list, right-click anywhere in the list and make sure that the options Show Disabled Devices and Show Disconnected Devices are
selected.
4. If the device is listed as Not Plugged In, try plugging in the device again.
5. If the device is listed as Disabled, right-click the device and choose Enable.
 
Step 2: Set up Video
No video:
If you'll only be recording the audio, or if there's no video at all, we recommend that you make the capture area smaller, so that video recording does not unnecessarily
take up your disk space. To do that, you can resize the capture area with your mouse, or enter smaller dimensions in the Movavi Screen Capture window. You can set
the capture area to as small as 16x16 pixels.
 
With video:
If you'll also be recording video, move the capture area over the video:

• Drag at the orange square in the center of the capture area to move the frame
• Drag at the corners of the frame to resize the capture area.

More on setting up the capture area

 
 
 
Step 3: Record
Click the REC button to begin recording. You will be given a 5-second countdown to start the audio playback (don't worry you will be able to trim the file later if you
accidentally record some silence). When you're done recording, click the Stop button.

 
Step 4: Save Audio
When the recording is finished, you will see a player window, where you can preview and save the recording as an audio file.
 
Trim the file:
If you've accidentally recorded some unwanted parts, like silence at the beginning or at the end of the file, you can easily trim them before saving the file. At both ends
of the progress bar, you will find a pair of triangular trimming markers. These markers control which part of the recording is saved in the output file. Move the triangle
markers so that the unwanted parts are outside of them.
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Trimming markers
Save the file:
1. If you're ready to save the audio file, open the Save as list and choose Video and audio formats.
2. Scroll to the very bottom of the list to find audio formats and choose the format you like. If you're unsure, you can use *.mp3, as it is the most widely supported format.
3. Click the Save button to start saving the video.
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Capture area
The orange frame defines which part of your screen will be visible in your screen recording.
 
Record full screen
To record a full screen video, open the list on the control panel and select your display.
Note: if you have enabled the capture control panel, it will be visible on full-screen recordings. You can disable it in the Screen Capture Preferences.
Also, the main Movavi Screen Capture window will also be visible, but you can use keyboard shortcuts or the tray icon to begin recording.

Record a window
Using the smart selection tool, you can select any window and the frame will be automatically set to its size and position.
1. Click the crosshair button on the Movavi Screen Capture window.
2. The screen will dim slightly. Move your mouse pointer over to the window you want to capture and click on it. An orange frame should appear around the window.
If you move the window, the capture frame will also follow.

Record a YouTube player
1. Open the list on the Movavi Screen Capture window. There, find the YouTube section and select the size you need. The smaller size is the regular player size, while
the larger size is YouTube's Theatrical Mode.

2. Click and drag the orange square  in the center of the capture frame to move it over the YouTube player.
Learn more about capturing YouTube
 
Record a standard size
You can select from any of the standard or widescreen sizes that match common screen resolutions and windows.
1. On the Movavi Screen Capture window, open the list under 'Select Capture Area'.
2. Select a size that fits your needs.

3. Click and drag the orange square  in the center of the capture frame and move it to the necessary position.
 
Custom frame size
You can set virtually any frame size for your recording using a number of ways:
 
Draw the capture frame
1. Click the crosshairs button on the Movavi Screen Capture window to enter smart selection mode.
2. The screen will dim slightly. Click and drag diagonally to draw the capture frame rectangle.

Exact size
If you want to set a specific size, enter the width and height into the boxes on the Movavi Screen Capture window:
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Drag the edges
Move your mouse pointer over the edge of the capture frame, and click-and-drag at them to change the size of the frame.

Moving the capture frame
To move the capture frame, click and drag at the orange square in the center of the capture frame to move it across the screen.

 



 

20

Sound
Movavi Screen Capture can capture sound from a variety of sources. 
 
System Audio
To capture audio from applications, music, videos, and other system audio, click the System Audio button to enable capturing sound from these sources.
 

on          off
Recording Devices
If you want to record audio from external devices:
1. Click the microphone button to enable device capturing.
2. Select the necessary device from the list.

on          off
 
If you want to record both system audio and an external device (for example, to capture Skype calls), simply enable both options.

Audio volume
Before you start recording, you can adjust the volume levels both for the system audio and your microphone. To change the volume, simply drag the sliders up or down.
 
This may be useful for recording tutorials with a voice-over to make sure that the microphone is always louder than the system audio.

Troubleshooting
Capturing system sound on Windows XP
Windows XP does not support recording from multiple audio sources: that is, you will not be able to easily capture system sound and an external audio device. However,
you can still capture system sound separately:
1. Click the microphone button to enable recording from audio devices.
2. Select Stereo Mix.
 
 
See also:
Recording only audio
Recording Skype calls
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Scheduling
You can use Movavi Screen Capture to record your screen at any time.
 
To set a time limit
If you want the recording to end automatically after a certain period of time:
1. Click the clock icon to open the capture time options.

2. Select the 'Stop capture after' option.
3. Enter the time after which the recording should end (hours:minutes:seconds).

To schedule a recording
You can record anything on your screen without even being at your computer, as long as you know when to start and end the recording.
1. Click the clock icon to open the capture time options.

2. Select the 'Schedule recording' option.
3. Next to Start time, enter the date and time when the recording should start.
4. Next to 'Stop capture after', enter the time after which the recording will automatically end (hours:minutes:seconds).

.
When the time comes, the recording will begin automatically. Before that, don't forget to set up the capture area and sound. You do not need to press the 'REC' button
for the recording to begin, however, please note that Movavi Screen Capture will need to be running at the specified time. To ensure that, you can enable autostart in the
Preferences.

Please note that if you haven't yet activated the program, the maximum capture time is two minutes for each video. To learn more about activating Movavi Screen
Capture, see the Activating Software section.
 
If you are starting a lengthy recording, make sure that you have enough free disk space for saving the temporary recording files.

program_preferences.htm#general_preferences


 

22

Highlighting events
If you're making a video tutorial, it can be very helpful to draw attention to onscreen actions.
 
Highlighting the cursor
To show mouse actions in your video, you can choose to display a standard mouse, highlight the cursor, and/or use an effect for mouse clicks.
How to highlight the cursor

Highlighted mouse and left click
Hiding the cursor
If you don't want to see the cursor on your recording, you can hide it so that it won't show up on the finished video even if you move it over the capture area.
How to hide the cursor
 
Showing the keystrokes
If you're using keyboard shortcuts, you can display every key and key combination that you press on your video.
How to show keystrokes

The key combination will appear at the bottom of the video
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Mouse cursor effects
Using mouse effects, you can use the mouse as a pointer and show your viewers where to click.
 
Show the mouse cursor

1. Click the mouse icon on the Movavi Screen Capture control panel to open the cursor options:  
2. In the Cursor options box, select the Show cursor option.
The cursor will now appear on your videos.
 
Highlight the mouse

1. Click the mouse icon on the Movavi Screen Capture control panel to open the cursor options:  
2. In the Cursor options box, select the Show cursor option if it is not yet enabled.
3. Select the Highlight cursor option.
4. To change the highlight color, click the square next to 'Highlight cursor' to open the palette and select a new color.
5. To change the diameter of the highlight, use the Size slider.
 
 
Highlight clicks

1. Click the mouse icon on the Movavi Screen Capture control panel to open the cursor options:  
2. In the Cursor options box, select the Show cursor option if it is not yet enabled.
3. Select the Highlight clicks option.
4. To the right of the 'Highlight clicks' option, you will see two color squares. Click the left or right square to change the color for the left or right mouse
button respectively.
 
 
Use a click sound

1. Click the mouse icon on the Movavi Screen Capture control panel to open the cursor options:  
2. In the Cursor options box, select the Show cursor option if it is not yet enabled.
3. Select the Mouse click sound option.
4. If you want to use your own sound effect, open the list and choose Add sound. Then, select the sound file that you want to use.
 
Hide the mouse cursor
If you don't want to see the mouse cursor on your video:

1. Click the mouse icon on the Movavi Screen Capture control panel to open the cursor options:  
2. In the Cursor options box, disable the Show cursor option. The cursor will now be transparent in your videos, even though you will be able to see it on your screen.
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Recording keystrokes
If you're making a tutorial that uses keyboard shortcuts, it's helpful to display them on screen for your viewers. Enable keystroke recording to show the keys you pressed
at the bottom of the video.
 
To enable keystroke recording:

1. On the control panel, click the keyboard icon: .  The keyboard options panel will appear.
 
2. In the keystroke recording options panel, select one of the options:

• Keyboard shortcuts only — only key combinations such as Ctrl+C or Shift+Control+Esc will be shown on screen. Letters and keys that do not cause an
action will not be displayed. 

• All keystrokes — each key you press will appear on screen, including letters and numbers.

Once enabled, the keystroke recording icon should turn orange .

To turn off keystroke recording, click the keyboard button once again and disable the options. 

Tips:

• Avoid entering any passwords or other sensitive information while you're recording a video with keystroke recording: if you share the video, your viewers will be able to
see each character you type.

• Keyboard shortcut recording does not work with the Windows key.
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Starting the recording
Begin recording
To begin recording screen activity, do any of the following:

• Click the REC button on the control panel.
• Use the start recording keyboard shortcut (F10 by default)
• In the system tray, right-click on the Movavi Screen Capture icon  and choose Start Recording.

 

You will be given a 5-second countdown before recording begins.

Pause recording
To pause recording, do any of the following:

• Click the Pause button on the control panel.
•

Click the Pause button on the orange panel at the top of the capture frame: 
• Use the pause capture keyboard shortcut (F9 by default)
• In the system tray, right-click the Movavi Screen Capture icon  and choose Pause.

 
When you're ready to resume the recording, the Resume button will be in the same location as the Pause button.
 
To take a screenshot
To save a snapshot of the capture area, do any of the following:

•
Click the screenshot button on the orange panel at the top of the capture frame: 

• Press the screenshot keyboard shortcut (F8 by default).

Screenshots are saved to the folder specified in the preferences. By default, it will be the \Videos\Movavi Screen Capture\Screenshots folder of your user directory.
 
Stop recording
When you're ready to finish the recording, do any of the following:

• Click the Stop button on the control panel.
•

Click the Stop button on the orange panel at the top of the capture frame: 
• Use the stop recording keyboard shortcut (F10 by default)
• In the system tray, right-click on the Movavi Screen Capture icon  and choose Stop Recording.

 
The recording will end, and you can proceed to saving the output video.
 
If you want to terminate the recording without saving the video and delete the temporary recording file, click Cancel on the main Movavi Screen Capture window.
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Troubleshooting:
Windows style changes when I start recording
If you have a Windows Aero theme (Windows Vista, Windows 7), disabling the transparency effects will free more resources and your computer will run faster during
capture. The Aero theme will return once you have finished capture. To disable this, open the Preferences and turn off the 'Disable Aero theme during capture' option
in Video preferences.
 
Capture doesn't start immediately
By default, you will see a five-second countdown after you press the REC button and before the recording begins. You can use this time to prepare for recording. If you
want the recording to start immediately, open the Preferences and disable the 'Show countdown' option.
 
An orange panel appears on my recording
During recording, you can use the orange panel on top of the capture frame to take screenshots, pause or stop recording, and keep track of the recording process. If you
don't want this panel to appear on your videos, open the Preferences and disable the 'Show capture control panel during recording' option.
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Saving the captured video
When you end the recording, you will see a player with the captured video which you can preview before saving.
 
Step 1: Choose a capture format
 
To save as a video file:
1. Click the 'Save as' box to open the list of output formats.
2. At the top of the list, click Video and audio.
3. Find the necessary format in the list and click on it to see more options.
4. Choose a video codec and resolution that you want to save the video with. To save the video without changing the resolution, choose the item marked with 'Same as
input'.
How to choose a resolution?
 
To save the video for a device:
1. Click the 'Save as' box to open the list of output formats.
2. At the top of the list, click Devices.
3. Find your device's manufacturer in the list and click on it to see more options.
4. Find your device's model and click on it to select it as the output format.
The format, resolution, and other media properties will be selected automatically to ensure compatibility with the selected device.
 
To save only audio:
1. Click the 'Save as' box to open the list of output formats.

2. At the top of the list, click Video and audio.
3. Scroll down to find audio formats at the bottom of the list.
4. Find the necessary audio format in the list and click on it to see more options.
5. Choose the item with the bitrate that you want. Bitrate affects how much audio quality will be retained after saving. To save with the original audio quality, choose the
item marked with 'Same as input'.

Advanced settings

If you need to save the video with specific properties, click the cogwheel button  next to the 'Save as' box to manually edit the media properties for video and audio.
 
Step 2: (Optional) Trim the video
If you have unwanted footage at the beginning or at the end of your video, you can trim it using the triangle markers  on the player's progress bar. Click a marker
and drag it towards the center of the progress bar to trim the video. After this, the fragments outside the markers will not be saved.
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Step 3: (Optional) Compress the video
At the bottom of the player window, you can see the estimated size of the output video. If you want to compress the video to a smaller file size:
1. Click the estimated file size to open compression options.
2. In the file size box, drag the Quality slider left to decrease quality and file size. Keep an eye on the quality in the brackets to make sure you don't set it too low.
3. Click Apply.
Learn more about compressing the video

Step 4: (Optional) Export the video
If you want to add the video to your iTunes library or share it on the web immediately after saving, you can do it using the export options when saving the video.
 
Add to iTunes – select this option to add the captured video to your iTunes media library.
You will need to have iTunes 6.0 and above installed on your computer to use this feature. You can get the latest version of iTunes from the official Apple page here.
 
Upload to – Click this option to open the list of available services and select the sites or hosting that you want to upload the video to. Once saving is complete, the Share
Online module will open, where you can prepare your files for uploading.
Learn more about uploading videos via Share Online
 
Step 5: Save the video
After you have selected the output format, click Save to start processing the video.

 
 

http://www.apple.com/itunes/download/
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Choosing a resolution
How to keep the original resolution
If you open the list of presets under Save as, you will see that some presets are marked with a specific resolution size, such as 720p or 1080p. While these resolution
sizes can help you easily scale your video if you've captured it using one of the standard sizes, they may not be as effective if you've captured it using a custom capture
area size.
 
To save your captured video with the original resolution, you will need to either choose a format from the General Video group (located under Video and audio formats),
or choose a format preset titled 'Same as input'.

 
How to avoid black bars
When you save or convert videos with a different aspect ratio (the ratio of the video's width to its height), the output file may come out with black bars around it. This
happens because a video of one size needs to be fit inside the new frame without deforming the image itself. Just imaging fitting a rectangle inside a square and vide
versa.

To solve this problem, you will need to either save the video without changing the resolution (see above), or change how you want the video to be placed inside the
frame. To do that,
 
1. Choose a resolution size that you want in the preset list. To avoid losing quality, it should closely match the size of the original video either in width or in height.

2. Click the cogwheel button  next to the Save as list to open settings for the chosen preset.
3. Find the Resize method list and open it. Here, you can choose the way your video will be fit inside the selected frame size.

Letterbox is the default method that saves videos with the least distortion, but may add black bars in the region around the video.
Stretch will literally stretch the original video to fill the whole screen, however, this may lead to visual distortions.
Crop will scale the video to fit the entire frame on the short side, cropping anything that does not fit. While some parts of the video will be cropped, the objects
inside the video will maintain their proportions.
Auto uses a combination of both stretch and crop methods.
 

Choose the most appropriate resize method depending on the content of your screencast. You can refer to the image in the Settings window for a preview. Click OK to
accept the changes and close the window.

Small resolution videos
For best results, choose a resolution size less than or equal to that of the capture area you used. Due to video compression restrictions, If you save your video to a larger
resolution, you will not get better quality, but the file size will be considerably larger.
 
Setting a custom resolution
To set a resolution that is not included in the list of presets:
1. Choose a preset with the necessary format. You can choose any resolution at this point.

2. Next to the Save as list, click the cogwheel button  to open the settings for the chosen preset.

3. Enter the necessary frame size in the Width and Height boxes. Note the link button to the right of the Height box: . By default, the width and height you enter will be
adjusted to fit the selected proportions. Click the link button to disable proportion constraining.
 
Please note that if you want to savmule videos for a mobile device, some devices may not support the new custom resolution. For best compatibility, use the same
aspect ratio and a smaller frame size than that of the device preset.
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Reducing output size
Long recordings with a large capture area size may take up a lot of disk space. When saving the video, you can see the estimated file size at the bottom of the player
window. This shows approximately how large the ouput video will be after saving with the currently selected format. 

Here are some things you can do to reduce the file size:
 
Use a smaller resolution
When you select an output format, choose a resolution that's slightly lower than the original video size. The resolution is listed next to each output preset:

For example, changing the resolution from 1080p to 720p can reduce the video up to half the size. However, note that resolution affects video quality, so setting a
resolution too low can reduce its quality.

 
Compress the video
When saving the video, you can reduce the quality in order to achieve a smaller file size.
 
1. Click on the estimated file size at the bottom of the player window to open compression options.
 
2. Drag the Quality slider to the left to reduce the video's bitrate. Bitrate is the amount of data in each second of the video. A slightly lower bitrate may not even be visible
to the eye, but it can significantly reduce the file size. The text in brackets will tell you if you've set the quality too low.
 
3. Click Apply to accept the changes.
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Publishing videos online
You can upload the finished videos straight to social networks and file hosting folders using an additional module – Movavi Share Online. Follow the steps below if you
want to learn to upload your captured videos online.
 
Before you start:
If this is your first time uploading videos from Movavi Screen Capture, you will need to download and install an additional module (it's free!). Click here to download the
installation file and then follow the instructions to install the software.
 
Step 1: Choose sites to upload
Before you save a video, click the Upload to option at the bottom of the player window and select the web sites or services that you want to upload the video to. Please
note that you will need to have an active account on the selected websites in order to upload videos and that some services impose a length restriction.

Step 2: Save the video
Click the Save button to begin video processing. After the output video is ready, the Share Online module will open with your file already in the upload queue. 
 
If you are using Share Online for the first time, you may be asked to provide your login details for the selected services. The information you provide will be used only for
authorization with the website so that Share Online can upload videos on your behalf.
 
 
Step 3: Fill in the details
In the file list on the left, click your Screen Capture Project file to select it. The right-hand pane will display several information fields for the selected video. Fill in the title,
description, tags, etc. This will help the video sharing service to categorize your video. Some services also allow you to set privacy settings.
 
Step 4: Upload the video
Click the Upload button in the bottom right-hand corner to begin uploading the video.
 

http://www.movavi.com/download-photo-video-uploader
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Saving previously captured files
As your record onscreen videos, they are first stored as files with the *.mscproj extension. These files are located in the directory you've specified in File Preferences,
or in the default \Videos\Movavi Screen Capture\Projects folder. You can later open these captured files in Movavi Screen Capture and save them in the format of your
choice.
 
To open the temporary files:
1. In the menu bar, open the Capture menu and select Open Captured File (Ctrl+O)
2. Select the *.mscproj file you want and click Open. You can now save or convert the video just like after any other capture.

program_preferences.htm#file_preferences
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Saving screenshots
You can save snapshots of any area of your screen, including videos playing in various media players.
 
Taking screenshots before capture:
1. Launch Movavi Screen Capture.
2. Set up the capture area to include the part of your screen you want to take a snapshot of, or click the list of standard resolutions and choose a variant youu need. For
more information, please see the Capture Area section.

3. Take a screenshot:

•  Select Take a Screenshot in the Capture menu
•  Or use screenshot shortcut key (F8 by default). You can change it to a custom key or key combination in preferences.

4. In screenshot saving window choose a destination folder for screenshots, choose suitable file type from Files of type list and finally click Save.
 
Taking screenshots during capture:

•  Select Take a Screenshot in the Capture menu,
• Or use screenshot shortcut (F8 by default). You can change it to a custom key or key combination in preferences.

 
After capturing video you will see a number of screenshots taken during capturing at the bottom of the saving window. You can also click on the number to open
screenshots folder. The screenshot destination folder can be changed in preferences.

Tip: if the main window is visible inside the orange capture area during capture (for instance, when
you capture fullscreen on a one-monitor personal computer), it will be visible on screenshots as well.

We advice you to minimize the main window during capture and use shortcut keys for taking screenshots..
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Screen Capture preferences
 
To open the program settings for Movavi Screen Capture, open the Capture menu and select Preferences.

The preferences are organized into four categories: General, Files, Keyboard Shortcuts, Video, and Audio.
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General preferences
The General tab allows you to change the interface language and set the folder where you want the captured files to be stored by default.
 

 Select the Automatically check for updates option to make sure your Video Converter is always up-to-date. Minor updates are absolutely free (for example, from
v.1.3 to v.1.4). For major updates users with purchased Movavi Screen Capture license will get a considerable discount.
 

 Send anonymous usage stats to Movavi – checking this box will allow Movavi Screen Capture to send usage statistics to our development team, enabling us to
fix any bugs you may encounter much faster, as well as add new features that you might be missing. The data sent by Movavi Screen Capture contains no personal
information, will not be disclosed to third parties and will be used for software improvement purposes only. You can find more information about usage statistics on our
Movavi Improvement Program page.
 

 Show countdown – with this option selected, whenever you start capture, recording will not begin right away, rather, you will be shown a 5-second countdown to give
you time to prepare.
 

http://www.movavi.com/mip.html
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File preferences
The Files tab of Movavi Screen Capture preferences allows you to manage the folders where you want Movavi Screen Capture to store its files. Click the arrow button
next to a folder to set a different location.

Directory for captured files: where your output videos will be saved. After you save a video, this folder will open automatically.
 
Directory for screenshots: if you take screenshots during capture, they will be saved to this folder.
 
Directory for temporary files:
When you record screen activity, Movavi Screen Capture first writes your video as a temporary project file with the *.mscproj extension. This file is stored in your
Directory for temporary files until you save it as a video or audio file. Besides, you can always open a project file and resave it in a different format.
 
By default, the files are stored even after you save the video, in case you want to reuse the temporary file and save it to a different format, however you can delete all

temporary files by clicking the trash can icon next to the Directory for temporary files .
 

 Delete temporary video files after conversion – with this option selected, the temporary files will be deleted immediately after you save the videos. This will help
you save disc space, however you will not be able to save the recording in a different format afterwards.
 
Directory for screenshots: when you take screenshots during capture, they will be saved to this folder.
 
Default screenshot format: when you take a screenshot, it will be saved with the selected format.
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Keyboard shortcuts
The Keyboard Shortcuts tab allows you to set your own custom shortcuts for such actions as starting or pausing the capturing process. On the left you can see
keyboard shortcuts for every action.

To change one of the shortcuts:
 
1. Click inside the box with the shortcut you want to change. The box will become blank.
2. Simultaneously press on keyboard the keys you want to use as a shortcut to the selected action. The box will now display your custom shortcut.
3. Click OK to apply the changes. To reset all the keyboard shortcuts to their original state, click the Reset to Default button.
 
In case you forget a shortcut, you can always look it up here in the keyboard shortcut settings.
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Video preferences
The Video tab contains advanced video settings. If you need your videos in another format, we recommend that you save them in the necessary format after capturing.
Please see the Saving video section for more details.

Codec: the codec which will be used for capturing videos. The H.264 codec is suitable for most video capturing scenarios.
 
Maximum capture frame rate: like in regular video, the frame rate will define how many frames will be captured each second. A lower frame rate will result in smaller
output size, however, the video may not turn out as smooth. The recommended frame rate is 20-30 frames per second.
 
Output frame size: defines the dimensions of the captured video. Full size means that it will be captured "as-is", while other frame sizes will result in some scaling to fit
the captured area into the specified frame.
 

 
For example, if you are capturing a 1280x720 screen with a frame size of 480x320, the captured image will need to be scaled down. Likewise, if the area you are
capturing is smaller than the output frame size, the video will need to be scaled up, which results in larger file size with no gain in quality.
 

 Enable SuperSpeed conversion – the SuperSpeed conversion method allows Movavi Screen Capture to save your recordings much faster if you select presets

marked with the green SuperSpeed icon .
 
Setting custom video preferences allows you to save time if you intend to always capture videos in one format, but some options like a higher frame rate and larger frame
size will require more resources. We recommend that you keep the default settings and convert your videos to the necessary format and frame size when saving.
 

 Enable Intel® hardware acceleration– if your computer is equipped with one of the latest Intel® processors, the captured videos will save much faster if you select

conversion presets marked with the blue Intel icon: 
 
For Windows 8 and Windows 10 users:

 Use alternative capture mode (not recommended) - turns on alternative capture method. Enable if errors or crashes occured during the capturing process. Not
recommended when there are no such problems.
 
For Windows Vista and Windows 7 users:

 Disable Aero theme during capture – if you are running Windows Vista or Windows 7, the transparency in the 'glass' Aero theme is harder to process and may
cause defects in the captured video, especially if you are using a slower computer. With this option enabled, your theme will be switched to the Windows Simplified
theme when you begin capturing. Once you stop capture, the original theme will be restored.
 
For users of Windows 7 and lower:

 Use DirectX for capturing – try this option if you are experiencing problems capturing some program windows. In Windows 8 and above, the capture method is
chosen automatically and this option is unavailable.
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Audio preferences
The Audio tab allows you to change the preferred audio quality, including the sample rate, number of channels, and bits per second.
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Help and support
If you have any questions or concerns regarding Movavi software, you are welcome to contact our support team. 
 
Write to us at suppport@movavi.com
or click the button on the right to ask a support specialist via live chat.
 
Please describe your problem in as much detail as possible; any screenshots or log files will allow us to help you faster. Our support team specialists may ask you
for additional information that is required to solve your problem: these may include your license key, log files, and files you were working with, but never personal
information. We value your privacy!
 

Have you checked the FAQ section?
Your question may have already been answered!

 
Frequently asked questions:
How to remove trial restrictions?
Why do my videos have "trial version" on them
What are the system requirements for running Movavi Screen Capture?
What formats can I save my videos in?
How to update the graphics card drivers?

mailto:support@movavi.com
http://www.movavi.com/support/#sales
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System requirements
 Minimum system requirements Recommended configuration

Operating system Windows XP*/Vista/7/8/10 with latest service packs and patches
Processor Intel, AMD or compatible processor, 1.5 GHz Intel, AMD or compatible processor, 2.8 GHz and above
Resolution 1024x768, 32-bit color 1280x1024 or higher

RAM Windows XP – 512 MB
Windows Vista, 7, 8, 10 – 1 GB

Windows XP – 1 GB
Windows Vista, 7,8, 10 – 2 GB

Available disk space 810 MB for installation
2 GB for ongoing operations**

10 GB

 Administrator permissions are required for installation

Additional features  Sound card for audio recording and playback
  Intel® hardware acceleration requires a compatible

Intel processor supporting Intel HD Graphics™ 2nd
generation or higher
Learn more

  For intended performance, make sure that your graphics
card drivers are up-to-date.
Updating graphics card drivers

* Windows XP does not support recording system sound simultaneously with audio devices.
** Free disk space is required to save the temporary recording file and the output video. The required amount of disk space will depend on the resolution, format, and
length of your videos.
 
 
Movavi Screen Capture may also run on slower machines, however, we cannot guarantee stable performance if the minimum requirements are not met.

program_preferences.htm#video_preferences
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Supported formats

Video Formats Supported Codecs

3GPP (.3gp), 3GPP2 (.3g2) H.263, H.264, MPEG-4

Audio Video Interleave (.avi) H.264, MPEG-4, MJPEG
Flash (.flv) FLV1, H.264
Flash (.swf) FLV1
Matroska (.mkv) H.264, MPEG-4, MJPEG, Theora
MPEG Transport Stream (.m2ts) MPEG-2, H.264
MPEG (.mpg, .vob) MPEG-1, MPEG-2
MPEG-4 (.mp4) MPEG-4, H.264
OGV – Ogg Video (.ogv) Theora
QuickTime (.mov) H.264, MPEG-4

WebM (.webm) VP8

WMV – Windows Media Video (.wmv) WMV V8

Audio Formats Supported Codecs

AAC – Advanced Audio Coding (.aac) AAC
FLAC – Free Lossless Audio Codec (.flac) FLAC
MP3 – MPEG-1/2 Audio Layer III (.mp3) MP3
OGG – Ogg Audio (.ogg) Vorbis
WAV – Waveform Audio File Format (.wav) PCM

WMA – Windows Media Audio (.wma) WMA 9
 
Supported Devices
 
Movavi Screen Capture supports a wide variety of devices from old and faithful classics to the newest flagships. You can find the full list of supported formats and
devices here.

http://www.movavi.com/screen-recorder/formats.html
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Updating graphics card drivers
If you encounter an error message asking you to update your graphics drivers, you will need to download a new driver from your graphics card manufacturer's website
and install it on your system. Some graphics card drivers also have a useful utility that notifies you when a driver update is available and updates the driver automatically.
Keeping your graphics card drivers up-to-date will ensure stable performance of applications and games on your computer.
 
Step 1: Find your graphics card manufacturer
1. Right-click your desktop and choose Screen Resolution
2. In the Screen Resolution settings window, click Advanced settings.
3. This will open your graphics card properties. At the top of the window, your graphics card model will be listed under the Adapter Type section. Note the full name of
the graphics card somewhere for later.
 
Step 2: Download the new version
Now that you've learned your graphics card manufacturer and model, go to the manufacturer's website and find driver downloads. There, look for the model or series that
you've found earlier and download the driver installation file. Some manufacturers may also offer a utility that will automatically find the necessary driver.
NVIDIA download center
AMD download center
 

Warning:
Only download drivers from the official manufacturer's website. Third-party websites offering driver downloads may contain malware.

 
Step 3: Install driver
Once the file is completely downloaded, run the installation file and follow the onscreen instructions to install the driver on your system. Your display may blink several
times in the process. After the installation has finished, it is advised that you restart the computer.
 

 
Updating NVIDIA® Driver
Modern NVIDIA graphics cards come with a special application called NVIDIA GeForce™ Experience that monitors driver updates and allows you to optimize your
computer's graphics performance.
 
1. Open the NVIDIA GeForce Experience application. It should already be installed on your system. If you cannot find the application, please try the method above.
2. In the Drivers section, click the Check for updates button to find the latest drivers.
3. When the application has found a newer driver, click the Download driver button. From here, the software will automatically download and install the necessary driver
for your system.

Updating AMD® or ATI® Driver
 
1. If you have an AMD or ATI graphics card, go to the Driver Download Center on AMD's official website.
AMD Driver Download Center
 
2. Download the auto detect utility and run it when the download has finished. 
Auto Detect Utility
 
3. The utility will then automatically find your graphics card and help you download and install the right driver for your system.
 
If the utility fails to find a driver for you, you can manually select your graphics card model and operating system on the Driver Downloads page and download the driver.
 
4. After the driver has downloaded, run the installation file and follow the on-screen instructions to install it.
 
5. After the driver has been installed, it is recommended that you restart your computer.
 

If none of the above steps have helped, feel free to contact our support team via e-mail support@movavi.com or live chat.
 
If possible, please include the name of your graphics card model (see Step 1), as well as screenshots of any error messages you have encountered. This will help our
support team specialists solve your problem quicker.
 
 

http://www.nvidia.ru/Download/index.aspx?lang=ru
http://support.amd.com/ru-ru/download
http://support.amd.com/en-us/download
http://www2.ati.com/drivers/auto/autodetectutility.exe
mailto:support@movavi.com
https://chatserver.comm100.com/ChatWindow.aspx?planId=1190&visitType=1&byHref=1&partnerId=-1&siteid=27345
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